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ATN TO ADOPT IMPROVED LISTSERV SOFTWARE
ATN began using Lyris over two years ago to provide electronic mailing list services. At that time, Lyris was the most
sensible solution to meet the demands of the growing number of mailing lists on campus, but in a rapidly changing
environment and marketplace, it is no longer providing superior service to the campus. Therefore, ATN is preparing to
adopt a different software solution at the end of Spring semester, and we would like to share more detail about the
reasons for the change, and we invite you to share your concerns with us.
First, let us say that we know how important it is to make this change as transparent as possible, to save all messages
and settings associated with current and past lists, and to maintain the current levels of service. Plans are already
underway to meet these needs, and we hope to hear from you about all the specific concerns you have.
Adopting different mailing list software has become necessary for serious, long-term maintenance reasons:
1) The list server currently hosts approximately 9,000 lists, with 400-500 created each semester for courses. The Lyris
software was adequate two years ago but now has insufficient resources to handle increasing list users and traffic.
2) The current list server has had approximately 23 unscheduled disruptions in services during the past year. When
these disruptions have occurred, we have not received good technical support from the company. This number of
unscheduled disruptions, and the corresponding time needed to fix these problems, is unacceptable. ATN needs to
switch to a product that is more reliable and easier to maintain.
3) ATN has the opportunity to switch to open source software, which will allow greater customizability for our specific
current and future institutional needs. In addition, costs for this software will be minimal.
Later this semester, ATN will hold an open meeting to preview and discuss the new software. To prepare for this
meeting and this change, we invite you to send your concerns to list-comment@unc.edu.
CIT'S APRIL 2002 BLACKBOARD CLASSES
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Introduction to Blackboard 5.5
This course is designed for instructors, teaching assistants, and IT support staff interested in learning the basics of 1)
posting content to Blackboard sites, 2) using Blackboard's communication tools, 3) customizing sites, and 4)
controlling access to them. Blackboard's strengths and limitations as a courseware platform will also be discussed. No
previous experience using Blackboard is necessary.
Dates and times:
Tuesday, April 16; 2:00 p.m. - 4:00 p.m.; Course #CI06-016
Tuesday, April 23, 2:00 p.m. - 4:00 p.m.; Course #CI06-017
Blackboard Online Gradebook and Assessments
This course comprehensively explores Blackboard's Online Gradebook and Assessment Manager tools. The course is designed
for instructors, teaching assistants, and IT support staff who have a good working knowledge of Blackboard but want to learn
more about the strengths and limitations of these tools.
Date and time: Tuesday, April 30; 2:00 p.m. - 4:00 p.m.; Course #CI07-006
To register call the ATN Training Center at 962-1160 and give the registrar the following information: your complete
name, department, affiliation (faculty, staff, or student), daytime phone number, and the course number.
KNOWLEDGEWORKS@CAROLINA SEEKS FACULTY PROPOSALS
knowledgeWorks@Carolina is a new initiative to provide:
-- a research organization for the study of technology in higher education and
-- a dedicated resource to faculty for the creation of educational interactive media projects called MediaBooks.
knowledgeWorks@Carolina is accepting faculty proposals for new MediaBooks. The knowledgeWorks@Carolina
development award will fund full production of your CD-ROM-based MediaBook and provide for partial to full release
time from your department/school to serve as the Subject Matter Expert for the project. The deadline for proposal
submittal is April 22, 2002. The RFP is available at http://www.unc.edu/knowledgeworks/2002RFP.htm.
For more information, contact Megan Bell, knowledgeWorks Assistant Director, at megan_bell@unc.edu or 843 -9922.
WHERE ARE WE GOING WITH E-BOOKS?
The UNC-Chapel Hill Scholarly Communication Working Group's April brown bag lunch meeting will feature Paul Gilster,
computer columnist for The News & Observer (Raleigh, NC). Gilster will give an update on what's happening (and not
happening) in the world of e-books. This presentation is co-sponsored with LAUNC-CH.
When: Tuesday, April 9, noon - 1:00 p.m.
Where: 2nd Floor Conference Rooms, Davis Library
For more information about the Scholarly Communication Working Group, link to http://ils.unc.edu/scholcom/index.html.
For more information about LAUNC-CH, link to http://www.unc.edu/lib/launcch/index.html.
NEW RESOURCE ON WEB ACCESSIBILITY
"Webaccess" is our campus email list for faculty and staff to post questions and share information on web accessibility
topics. Elsewhere on the Web there is a growing community of similar email lists that cover technical aspects of
accessible web design. A new web page, "Email Support Resources," lists some of the more popular ones. The list is
available at http://www.unc.edu/webaccess/listservs.html.
To subscribe to Webaccess, link to http://listserv.unc.edu/cgi-bin/lyris.pl?enter=webaccess
For more resources of accessible web design, link to http://www.unc.edu/webaccess/
UNC LINKS NEWSLETTER
UNC Links, published by The University of North Carolina's Division of Information Resources, offers a monthly update
on IT initiatives from the sixteen constituent institutions of The University of North Carolina campuses. The publication
serves as a vehicle for information technology dialogue among IT colleagues, chancellors, and others. UNC Links is
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available at http://www.northcarolina.edu/ir/newsletter/newsletter.cfm.
ATN TRAINING CENTER CLASSES FOR APRIL 2002
The April 2002 ATN Computer Training Class Schedule is now available at
http://www.unc.edu/atn/training/schedule/schedule.html
ATN's computer classes are open to UNC-Chapel Hill faculty, staff, undergraduates, and graduate students.
New classes offered:
Photoshop 6.0: ImageReady
Prerequisite: Photoshop: Web Graphics, Photoshop: Selection Techniques, and Photoshop: Layers.
This workshop focuses on using the ImageReady program included with Photoshop 6.0 to create interactive images for
the web.
Tuesday, April 30; 8:30 a.m. - 10:30 a.m.; Course # PH07-001
New Microsoft XP classes:
PowerPoint XP: Introduction
Prerequisite: Windows Getting Started or equivalent experience.
Friday, April 12; 11:00 a.m. - 1:00 p.m.; Course #PT15-004
PowerPoint XP: Formatting & Design
Prerequisite: PowerPoint XP Introduction or equivalent experience.
Learn how to work with slide masters, slide color schemes and backgrounds, create graphics, and work with objects.
Friday, April 26; 11:00 a.m. - 1:00 p.m.; Course #PT16-002
Word XP/2000: Increasing Efficiency
Prerequisite: Word XP/2000 Basic Formatting or equivalent experience.
Learn about AutoText, AutoCorrect, finding/replacing text, bookmarks, the spelling checker, and more in this class.
Thursday, April 25; 11:00 a.m. - 1:00 p.m.; Course #WD46-001
Excel XP/2000: Introduction 1
Prerequisite: Windows Getting Started or equivalent experience.
Thursday, April 4; 3:00 p.m. - 5:00 p.m.; Course #XL33-004
Friday, April 5; 12:00 noon - 2 p.m.; Course #XL33-003
Thursday, April 11; 5:30 p.m. - 7:30 p.m.; Course #XL33-005
Excel XP/2000: Introduction 2
Prerequisite: Excel XP/2000 Introduction 1 or equivalent experience.
Learn how to use workbooks, autofill, advanced editing, formatting, printing options, custom toolbars, and more.
Thursday, April 11; 3:00 p.m. -5:00 p.m.; Course #XL34-004
Friday, April 12; 12:00 noon -2:00 p.m.; Course #XL34-003
Thursday, April 18; 5:30 p.m. - 7:30 p.m.; Course #XL34-005
Excel XP/2000: Formulas and Functions
Prerequisite: Excel XP/2000 Introduction 2 or equivalent experience.
More in-depth work with entering formulas, functions, operators, as well as absolute and relative references.
Friday, April 19; 12 noon - 2:00 p.m.; Course #XL35-002
Excel XP/2000: Data Management
Prerequisite: Excel XP/2000 Introduction 2 or equivalent experience.
Need to create an easy database so that you can sort, or select out information for reports? Try out this class.
Thursday, April 18; 3:00 p.m. - 5:00 p.m.; Course #XL36-001
Excel XP/2000: Graphs
Prerequisite: Excel XP/2000 Introduction 2 or equivalent experience.
Learn how to create pie, bar, scatter, and other charts using Excel.
Thursday, April 25; 3:00 p.m. - 5:00 p.m.; Course #XL37-001
THE TECHNOLOGY SOURCE MARCH/APRIL 2002 ISSUE
The March/April 2002 issue of The Technology Source, a free refereed e-journal edited by James Morrison, professor
emeritus, UNC-Chapel Hill School of Education, is now available online at http://ts.mivu.org/.
The purpose of The Technology Source is to provide thoughtful, illuminating articles that will assist educators as they

file:///G|/CDR/ITS_newsletter_archives/ITS_newsletters/archives/citations/citations69.html[10/5/2011 10:37:44 AM]

ITS Teaching and Learning: CITations #69
face the challenge of integrating information technology tools into teaching and into managing educational
organizations. Issues include commentaries, case studies, reports on faculty and staff development, articles on the
virtual university, and links to higher-education websites.
The Technology Source also sponsors Author Forums -- free webcasts that allow participants to interact directly with
Technology Source authors via their desktops. For a schedule and to register for an Author Forum go to
http://www.horizonlive.com/lecture/index.html.
ITRC TIP: HOW TO HIDE TABLES IN ACCESS 2000
There are a number of ways you can keep curious eyes out of your Access 2000 data. One way is to password-protect
your files. Another is to simply hide the Database Window.
A third way to disguise your tables is to rename them by adding the "usys" prefix to the table's name. When you do,
you're changing the table to a system object, so that as Access 2000 scans the files in the working directory, it will
skip the tables with the usys prefix when it populates the Database window.
When you're ready to see the table again, you have a couple of options. First, you can manually remove the prefix
from the file you renamed. Or you can tell Access 2000 to display hidden objects. To do so, do the following:
1. Go to the Tools Menu.
2. Select Options and click the View tab.
3. In the Show section, select the System Objects check box.
4. Click OK.
ITRC TIP: COPY AND PASTE UP TO 12 PIECES OF INFORMATION AT ONCE
If you're constantly copying text and data between different Office programs, here's a way to save time by copying
multiple items at once. For example, you can copy a chart in Microsoft Excel, switch to Microsoft PowerPoint and copy a
bulleted list, switch to Microsoft Internet Explorer and copy a page of text, and then switch to Microsoft Word and
paste the collection of copied items into your document. Here's how:
1. In any Office 2000 program, on the View menu, point to Toolbars and click Clipboard to display the Office Clipboard.
2. Select an item you want to copy.
3. Copy the item into the Office Clipboard by clicking Copy on the Edit menu or clicking the Copy button on the
Clipboard toolbar.
4. Repeat steps two through four until you have copied all the items (up to 12) that you want to paste elsewhere. If
the item you want to copy is in another program, switch to that program first.
5. In an Office program, click where you want to paste the items.
6. To paste all the items at once, click Paste All on the Clipboard toolbar. Or, to paste the items one at a time, click the
icon for the item you want to paste.
For more computing assistance, contact the Information Technology Response Center, Wilson Library, Suite 300.
Walk-in Hrs: 7:30 a.m. to 5 p.m.
Phone: 962-HELP -- 24 hours/7 days a week
Email: help@unc.edu
Web: http://www.unc.edu/atn/itrc/
CITATIONS TIPS ARCHIVE
The ITRC, CBT, and Lyris tips published in CITations are archived on the Web, so you can locate tips without having to
search through all the back issues. The tips archive is at http://www.unc.edu/cit/citations/tips.html
CONFERENCE ANNOUNCEMENTS
Stay informed about technology conferences with the CIT's "Education Technology and Computer-Related Conferences"
at http://www.unc.edu/cit/guides/irg-37.html and "Calendar of World-Wide Educational Technology-Related
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Conferences, Seminars, and Other Events." The calendar is at http://confcal.unc.edu:8086/
2002 CITATIONS PUBLICATION SCHEDULE
April 12 & 26
May 10 & 24
June 7 & 21
July 12 & 26
August 9 & 23
September 13 & 27
October 11 & 25
November 8 & 22
December 6 & 20
CITations welcomes announcements from all UNC-Chapel Hill campus organizations involved in instructional and
research technology. To have an announcement considered for publication in CITations, send email to Carolyn Kotlas,
kotlas@email.unc.edu or call 962-9287. The deadline for submissions is noon the day before the publication date.
HOW TO SUBSCRIBE OR UNSUBSCRIBE TO CITATIONS
CITations is published twice a month by the Center for Instructional Technology. Back issues are available on the CIT
website at http://www.unc.edu/cit/citations/
For more information about the CIT, see our Website at http://www.unc.edu/cit/ or contact our office at 962-6042.
To subscribe to CITations, link to http://mail.unc.edu/lists/read/subscribe?name=citations
To unsubscribe to CITations, send email to listserv@unc.edu with the following message:
unsubscribe citations
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